Color Plans Not Just Pretty Pictures
Mathew Miller – SMPC Architects

What is a color plan? What do you use a color plan for? How do you create color plans in Revit? In this class we will look at these three questions and answer them. We will discover what Revit thinks a color plan is. As the old saying goes a picture is worth a thousand words, so we will look at how color plans can give us information about the plan as well a pretty picture. Since there are many ways to actually add colors to the plan in Revit we will look at some of these different methods and how to use the methods together to get the desired information out of the model.

Learning Objectives
At the end of this class, you will be able to:
- See the different uses for color plans
- Understand how to define colors from information in the model
- Understand how to control the colors of different object in a plan
- Understand how to color different types of objects with filters

About the Speaker
Mathew Miller is a recently registered Architect in the state of New Mexico. He is the BIM systems manager as well an Associate, with SMPC Architects in Albuquerque, New Mexico, a member of CSI. He received an Associate’s degree of Applied Architecture from the Denver Institute of Technology, a Bachelor of Arts and a Master of Architecture from the University of New Mexico. Mathew has been working in the AEC industry since 1992 and working with Revit since 2005. He has been writing the Revittize blog since 2008. He has been a member of the U.S. National CAD Standard Project Committee, National BIM Standard Project Committee, and was the NCS UDS module task team chair for version 5 Mathew is the Vice President of the 505 BIM Users group.

m.miller@smpcarchitects.com

Throughout this paper you will find hyperlinks to my blog where I talked about the subject. Some of the blog entries will have additional information that is not covered in this paper.
What is a Color Plan?
This would seem like an easy question to answer right. A color plan is a plan that has color, right, but we are talking about Revit here and answers are never quite that cut and dry. Revit’s definition of color plans is a little broader than just a color fill, but also includes any fill pattern. I guess the phase Color plan is deceiving and really should be called graphical plan to convey information, since that is really what we are doing.

http://revittize.blogspot.com/2014/10/color-plans.html

What do you use a color plan for?
Now that we have answered the first question let’s look at the second. What do you use a color plan for? There are many reasons to create a Color plan. The main reason to create a graphical plan goes to the age old saying “a picture is worth a thousand words”, meaning we create a Color plan to convey information about the project. Here is a few examples for using a Color plan. I'm sure that you can think of other reasons to create a color plan to convey some piece of information about your own projects.

Presentation – to convey information about a project to clients or other entities without writing up a thousand word dissertation about the proposed design.

Code plans – to convey information about a project Occupancy Area and fire ratings to code officials
Site planning – to convey information about how the site of the project is laid out

Space planning – to convey information about how to fit the program of the project into the building

Project Phasing – to convey information about how the project is being phased
**Finish Plans** – to convey information about the finishes of a project

**Evacuation plan** – to convey information about how to evacuate the building

**Model Management** – to convey information about a project’s workset ownership as well as finding conflicts between different systems
How do you create color plans in Revit?
Now that we know why we would create a Color plan lets go through some ways to create a color plan. There are multiple ways to create a color plan in Revit. Before getting into those methods let look at some of the fundamental systems that we need to understand before getting into some of the methods it takes to make a color plan.

Materials
In regards to Color plans the only thing about Materials you need to understand is the Graphical tab. The Graphical tab allows you to control and define surface and cut patterns of the materials of objects. It also allows you to add a transparency to an object. Understanding how to control the color of materials will be helpful when defining some types of color plans.
Filters

Revit has 4 types of filters, Information, Selection, View and Phase filters.  

**Information Filters** are mainly for Schedules, when you want to see particular information in your schedule.

**Selection Filters** are for when you only want to select particular objects.

**Phase filters** allow you to control how existing phases look differently than the newest phase.
**View filters** are filters that allow you control how objects are displayed in the views.

If you do not currently use filters after this class you will be using them much more. When it comes to color plans View filters are what you will be working with the most. View filters will allow you to control the graphics of objects within the same category.

[http://revittize.blogspot.com/2015/01/create-view-filter.html](http://revittize.blogspot.com/2015/01/create-view-filter.html)

To create a View filter there are two paths to follow.

**Path 1**
- Open your visibility graphics dialog box (shortcut key VV or VG)
- Go to the Filter Tab
- Click the “Edit/New” button
- This will take you to the filter creation dialog box.

**Path 2**
- Go to the View Tab
- Click the Filters button.
- A filters dialog box will appear. Click the New button
- The Filter creation dialog box will appear.
Path 1 is good when you are creating View Filters on the fly and want to apply them right away. Path 2 is mainly for setup purposes, when you are creating a bunch of them at a time and are not going to apply them to a view right away.

As an example create a view filter to filter out all the 1 hour walls in the project.

- Go to the View Tab
- Click the Filters button.
- A filters dialog box will appear. Click the New button
- The Filter creation dialog box will appear
- Clicking the new filter button
- From the filter name dialog box that pops up type in the name of the new filter, in this case name it 1HR, then click the ok button.
- With your new filter highlighted select the category of the objects you want to apply the filter to, in this case select Walls
- Apply a filter rule, Click the radial button that says “none”.
- From the list select the parameter to filter against, in this case select “Fire Rating”
- In the box below the parameter box select the filter criteria, in this case select “equal”.
- In the next field type the value you are looking for, which in this case is 1.
- After that click the ok button, and you have created a view filter.

Project Parameters

When creating a view filter you need a parameter to filter against. When the project does not have the right parameter that you need to filter against you will have to create it. The type of parameter that you will create is a project parameter. Project parameters can be created for any type of Revit category and they can be transferred between projects by using the transfer project standards command.

http://revittize.blogspot.com/2015/02/filtering-with-parameters.html

Create a new parameter

- Go to Manage tab
- Click the Project Parameters button
- From the Projects Parameters dialog box click the Add button
- From the Parameters Properties dialog box
  - Name the Parameter
  - Select the Parameter type *(Typically you will want to use the Text type, to create a parameter you want to filter against)*
  - Select category that the Parameter affects
Visibility Graphics

As Revit users you all probably know that visibility graphics is what allows you control how different Revit objects are viewed in each view.

The Projection/Surface section of the visibility graphics dialog lets us to control the graphics of the surface condition of objects. In plan views we are talking about controlling the graphics of objects like furniture floors or any other object we are looking down on in that view. In most color plans I usually use this section of the Visibility Graphics to make objects transparent so that the color fill of the area is visible.

The Cut section of the visibility graphics dialog allows us to control the graphics of objects that are being cut through. In plan views we are talking about controlling the graphics of objects like walls windows doors or any other object we are cutting through in that view. In most color plans you can use this section of the Visibility Graphics to fill the walls in.

http://revittize.blogspot.com/2014/10/color-fill-walls.html
As an example here is a piece of furniture where the furniture wants to fade into the background.

- Open the visibility graphics dialog (short cut keys of VV)
- Go to the Model tab
- Select the category of Furniture
- Change its transparency to 100%
- Click ok to apply the change

Now fill the walls with solid dark grey color.

- Open the visibility graphics dialog
- Go to the Model tab
- Select the category of Walls
- Change the graphic override for Cut Patterns to Solid dark grey
- Click ok to apply the change
As you can see the wall became filled, but what if you want to show the fire rated walls differently. Within the wall category there isn't a sub category for the fire ratings, but earlier we made a 1 hour wall filter, so let's use it now.

- Open the visibility graphics dialog
- Go to the Filter tab
- Click the Add button
- Select the 1 HR filter we created
- Click ok – to add the filter
- Change the graphic override for Cut Patterns to Solid Red
- Click ok to apply the change

You can use this method for code plans, or just when you are trying to understand if you have the right partition in the right place. This method is also quickly and easily applied to many views by use of View Templates.

**View Templates**

A view template is a collection of view properties that can be assigned or applied to multiple views. If you have a multiple story building you can use view templates to make sure the same view settings are used on all of the views. You can have a view template for each style to control settings for the visibility/graphics overrides of categories, view scales, detail levels, graphic display options, and more.

[http://revittize.blogspot.com/2014/01/assign-view-templates-for-every-view.html](http://revittize.blogspot.com/2014/01/assign-view-templates-for-every-view.html)

[http://revittize.blogspot.com/2013/10/view-template-types.html](http://revittize.blogspot.com/2013/10/view-template-types.html)
Hatch patterns

If you have ever created a hatch pattern in Autocad this is the same thing only using the Revit annotation tool of Filled Regions.

Go to any view you want to add color to. Go the annotation tab and click the filled region button. Use the drawing tools and just like in Autocad to define the area you want to add a hatch pattern to. Just like Autocad you can adjust what the pattern is. Just like Autocad this takes a bit of time to create these hatch patterns. Just like Autocad you can lock the lines that define the hatch pattern to objects in the view, this add times to the creation, but at least than the hatch pattern will move with the objects in the view. That is unless you get an error message asking you to remove association.

Even though this method might be a work flow you may be use to don’t use on a regular basis. This method doesn’t give you any information about the area being defined. From the properties of the hatch pattern the hatch pattern can easily be switched from hatch pattern style to another. To add the hatch pattern to another view it is a little more time consuming. Other methods gives you information about the area being defined and are twice as quick to define. The only reason why I’m even showing this at all is to show what not to do.
Color Scheme
The Color Scheme method is a good method to use when creating Code plans, Presentation drawings, Space plan drawings, Finish Floor plans, Evacuation plans, and many others. In some ways the Color scheme method is like the hatch pattern method only it’s a lot more intelligent. With Color schemes you are either using Rooms or Area, and both have a lot of parameters attached to them which make them smarter than a hatch pattern. In many cases it is better to create a color plan from an area plan rather than a room.


To create a color plan from an color scheme using an Area Plan

- Create Area Plan
- Go to the Architecture tab
- Behind the Area button we select Area plan from the pull down menu.
- From the New Area Plan menu select the level you want to create the area plan from
  
  When the dialog menu pops up asking you to automatically create the boundary lines I typically click the No button, because I want to place the area lines myself so that I understand when the area lines are and what is defining them.

- Click the Area boundary button, and start drawing your area lines.
  
  I tend to use the pick tool and pick the walls that are defining the areas. I can also just draw line. Using the pick tool usually locks the area lines to the walls you picked.
Create Areas

- Go to the Architecture tab
- Behind the Area button we select Area from the pull down menu
- Place the areas within the plan

The color/fill pattern for color schemes are defined by the parameters of the Area or Room.

Define a New Color Scheme

- Go to the properties of the view and click the Color Scheme Button
- Click the new color scheme button under the list of color schemes.
- Give it a name
- Select the parameter we want to define the color by
- Click the button under the word Color and a list of area parameters pops up
- Once you select a parameter a list will appear that shows the variations that are currently listed within that parameter.
- You will then want change the automatic color or pattern, that is defines for each of the listed items. The Automatic colors are not usually very pleasing.
- Click ok to apply color scheme to the view
Create/Apply an Area scheme to the view

- Go to the properties of the view and click the Color Scheme Button
- Select the color scheme you want to apply to the view
- Click ok to apply color scheme to the view

Once a color scheme has been applied to an Area or Room it is easy to change the pattern simply by changing the parameter that is defining the pattern. It is also easy to change the parameter that defines the color schemes. To do this simply go the color scheme dialog box and change the parameter, a new list will appear, that you will need to adjust to your liking.

**Floor Types**

You can use different floor types to create color plans. Most of the times you would you use this method when creating a finish floor plan, where you are trying to depict different floor materials, or you are trying to show the tile pattern of a room, or you are trying to get an accurate square footage of the floor finish material. Whatever the reason for the color plan you are creating a finish floor type that is separate from the structural floor. Yes you can add the finish layers to the structural floor, but when the structural engineer has control of the structural floor in their model and you as an Architect just want to add your finish materials you can’t. So instead of creating a floor that sits in the exact same place as the structural model which creates conflicts when you perform a clash detection on the model, you create a floor that just has the finish layers that is sitting on the structural floor.


To use finish floor types you need to create a floor type that just has the layers of the finish floor. For example you have a tile floor in an area. The finish floor will have a layer of the thickness of the tile then it will have a layer that is the thickness of the mortar.

This method of creating color plans is just as time consuming as the hatch pattern method, the difference is that this gives you a lot more information that is useable. There are 3rd party programs that automate this process. At Autodesk University 2014 Marcello Sgambelluri presented a presentation talking about Dynamo where he suggested a method of automating the creation of finish floors using Dynamo.
Massing objects

How many of you have ever created a bubble diagram?
How many of you have ever created a space planning diagram?
Now how many of you have ever wanted to create these diagrams in Revit?

In Revit you can create these diagrams with color schemes but if you wanted to move the areas around it would be easier to use mass objects. When using mass objects for space planning you are given the flexibility to move the mass objects around like Lego’s or building blocks to figure out the best configuration of the space. Like Lego’s you are not just creating objects that are viewed in a plan view but you are also creating objects that can be viewed in elevation or even a 3d view.

http://revittize.blogspot.com/2015/02/color-plan-by-mass-object.html

There are two types of Mass objects that can be created, Mass object family, or in-place Mass object. In-place Mass object can only be used in the project that they were created in, and a Mass family object can be used in multiple projects.

To color a Mass object there are two techniques. You can assign materials to the mass objects and control the colors of the object through the Materials menu. Another technique of coloring mass objects is using filters. What’s nice with filters is that you can turn certain things off in the view as well. For controlling the color of the mass objects using filters is a faster technique then using materials.
To change the color of a mass family object with material you should create a custom parameter that controls what the material is assigned to the mass family object. This parameter would want to be an instance parameter so that the material of the mass family can be quickly changed. For in-place mass objects it’s a little more time consuming. To change the material of in-place mass objects you have to edit the mass then change the material that is assigned.

With filters you can use a parameter that is common to both In-place Mass objects as well as Mass family objects to control the color the mass objects. With filters if you change the parameter controlling the color the color will change quickly. With filters you can use a different parameter in a different view to create a different color scheme for the same mass object, which you cannot do with Materials. To create a view filter for a mass object is the same process as you would use to create a filter for a wall. The only difference is that you are selecting the mass category instead of the wall category.

**Workset**

Workset color plans, allow you to see what objects are on what workset. This is particularly useful when you have a lot of worksets in your model. When working with a large project team this method also allows you to see who has control of particular objects in the model. The only reason to use this method of color plan is for model management. For final graphics one of the other methods is better. To create a workset color plan you simple select the view workset button at the bottom of the view. From the Dialog box that pops up select the option you want to view.

http://revittize.blogspot.com/2014/04/review-worksets.html
Bring it all together

When I was in school I was asked several times what program I had used to create my renderings and my answer was usually a list of programs from Autocad to Photoshop. With the six methods of creating color plans described here the answer to the question of what program I created the rendering from has changed from a list of programs to just Revit. Now the question is what Method did I use to create the color plan, and in many cases the answer will be a combination of methods.

Presentation

Visibility Graphics to Fill the walls
Color Scheme to fill the areas

Code plans

Visibility Graphics with filters to Fill the Rated Walls
Color Scheme to fill the occupancy areas

Site planning

Color Scheme to fill the landscape and hard scape areas
Massing objects to fill the buildings